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PREFACE

Computers play a vital role in the modern world, and even the most basic jobs today involve technology. Therefore, 

computer education becomes essential in any student’s development. Expertise in computing enables children 

think critically, be more creative and innovative, giving space for collaborative work and individual effort.

The series of books (Class III – IX) aim to holistically develop digital skills, keeping pace with the dynamically 

changing industry requirements. 

IT education has no boundaries and irrespective of the field of work, each one is expected to have the following 

digital skills:

 MS Office (MS Word, MS Excel, MS PowerPoint)

 Photo / Image Editing

 Programming

 Website development

The enriched curriculum therefore covers a wide variety of topics across various classes: TUXPAINT; MS Word 

2007 (Level I, II & III) ; MS Excel 2007 (Level I, II & III); MS PowerPoint 2007 (Level I & II); Image / Photo editing 

software using GIMP 2.8; Scratch Programming; HTML Programming; Web creation tool using WordPress. 

The curriculum uses only open source software (freely available on the Internet) installed in Windows 7 Operating 

system.

A brief description of every concept and its application / purpose is provided in every lesson with colorful screen 

shots. This not only attracts the readers but also gives them an experience of self-learning. ‘Activity Based Learning’ 

exercises have been included as part of the curriculum. 

We hope this text book finds its place in the readers’ library for future references.
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Activity 1 : Load MS Word window from Windows

Start  All Programs  Microsoft office  Microsoft Word

Activity 2: Recall the following Navigation keys. 
•	 Down/Up,	Right/Left	arrow	keys,	End/Home	keys.

•	 Ctrl	+	Home/End

Open the document called KiteWithoutThread.docx
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FoRMATTINg TExTCh
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•	 Press	Ctrl + End keys together to go to the end of the document.

•	 Press	Ctrl + Home keys together to go to the beginning of the document.

•	 Close	the	Word	window	by	quitting	Word.	(File	Exit)

Activity 3a: Create a new blank document and type the following in it.

Activity 3b: Close the Word window and click don’t Save when Word shows the following 
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Activity 4: Type the following in a blank document.

(a)	 In	the	beginning	of	the	poem,	write	the	heading	“AT	THE	LAST	WATCH”.	(Use	the	arrow	key	to	go	to	the	

beginning of the first line, type the title and press the Enter key twice.)

AT	THE	LAST	WATCH

Pity, in place of love,

That pettiest of gifts,

Is but a sugar-coating over neglect

(b)		 After	the	last	line,	type	the	name	of	the	poet	“-	Rabindranath	Tagore”.	(Go	to	the	end	of	the	last	line,	press	

Enter key twice and type the poet’s name)

To a street beggar,

Only to forget the moment the first corner is turned 

I had not hoped for anything more that day.

- Rabindranath Tagore

(c)  Select the entire text and press the space bar key. What happens? (Use Ctrl + A) 

 _______________________________________________

(d)  Now click the undo button from the Quick Access toolbar. What happens?

 ______________________________________________

 _______________________________________________

(e)  Press the Redo button. What happens? 

 _______________________________________________

 _______________________________________________

(f )  Select the first line “Pity” 

g) Click the Copy button on the Home tab.

(h) Paste it at the end of the document, below the poet’s name. (Use the arrow keys to move to the last line, press 

Enter key if necessary and click the Paste button on the Home tab) 
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(i) Click the Paste button four more times.

Pity,in place of love

Pity,in place of love

Pity,in place of love

Pity,in place of love

(j) Select the entire document and copy it to a new blank document. (Ctrl+A, Copy button, File New, Paste 

button)

FoRMATTINg TExT
Formatting means changing the appearance of the document to make it look attractive. This can be done by chang-

ing the font type, font size, font color, text alignment, adjusting margins and bold facing, italicizing, underlining 

the text, etc. There are two types of formatting in MS-Word.

•	 Character Formatting : It is applicable to the selected text.

•	 Paragraph Formatting : It is applicable to the entire paragraph.

There are several ways in which we can do Character formatting. To use any of the Character formatting options 

available, the text has to be selected first and then only any change can be made to it. The Font group of the Home 

tab has many options to format the text in a document.

When we move the mouse pointer over the selected text or click on it, a mini Toolbar appears with some options 

to format the text as shown below:

Now, click on the Font dialog box launcher in the Font group. A Font Dialog box appears as shown below. The box 

has many options to format the text of a document.
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In Character formatting, the following options can be used in the Home tab.

OPTION DESCRIPTION

Font: Changes the font type.

Font Size: Changes the font size.

Bold:Converts the text to bold and vice versa. (Shortcut - Ctrl + B)

Italics:Italicizes the text and vice versa. (Shortcut - Ctrl + I)

Underline: Underlines the text and vice versa. (Shortcut- Ctrl + U)

Changes the text color.

•	 To	format	the	font,	select	the	text	to	be	formatted.	Click	on	the	Home	tab. 
 Choose the Font, its size and the color from the Font group.

•	 A	list	of	the	different	type	of	fonts	are	displayed	in	the	Font	drop-down	menu.

•	 The	size	can	be	chosen	from	the	Font	Size	drop-down	menu.

•	 To	choose	the	font	color,	select	the	text	and	then	choose	the	desired	color	from	the	Font	color	drop-down	
menu.
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ALIgNMENT oF TExT

The alignment of  text means the manner in which the text is placed between the left and the right margin of a 

page. There are many ways to set the alignment as shown below:

ALIgNMENT dESCRIPTIoN

   			Align	Left
The text is aligned along the left margin

       Align Right  The text is aligned along the right margin

       Center          
The text is placed between the left and right margin

       Justify       
The text is evenly aligned from both left and right margin

CHANgE CASE  

Word changes the case of the selected text. These are the options in the dialog box:

•	 Sentence Case – It capitalizes the first letter of each sentence in the selection.

•	 Lowercase – It changes all the capital letters to small letters.

•	 uppercase – It changes all the small letters to capital letters.

•	 Capitalize each word – It changes the first letter of every word to capital letter.

•	 Toggle Case – It changes all the capital letters to small letters and vice versa.

INdENT

Indent is the increase or decrease of space between the left and right margin of a paragraph. In Word, the word 

indent is used to describe the distance, or number of blank spaces used to separate a paragraph from the left or 

right margin.

FoRMAT PAINTER  

Format Painter is used when you want to copy formatting from one item to another. For example, if you have 

written text in Word, and have it formatted using a specific font type color, and font size you could copy that for-

matting to another section of text by using the Format Painter tool.

Activity 1:
•	 Open	Food	groups.docx.

•	 Change	the	title	to	upper	case.	

•	 Increase	the	title’s	font	size	to	16.	

•	 Center	the	title.

Anuradha
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•	 Format	the	text	in	the	following	way.	Use	the	Format	Painter	to	copy	the	formatting	of	one	text	to	another	
text.

Names of food groups Arial font, size 14, Red color, Boldface

Nutrition Times New Roman, size 12, Italics, Blue color, Capitalize Each Word

Benefits Comic Sans MS font, size 10, Boldface, Green color

•	 Change	the	title	to	“Benefits	of	eating	nutritious	food”.

•	 Left	align	the	title.

•	 Right	justify	the	subtitles	of	the	paragraph

 BRAIN dEVELoPER 

I) WRITE WHAT THESE TooLS do
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II) TICk THE CoRRECT oPTIoN

(a)  Shortcut combination to make the text italic is ………….. 

 (i) Ctrl + B (ii) Ctrl + I (iii) Ctrl + C

(b) …………. means changing the appearance of the document to make it   more attractive.

 (i) Selecting (ii) Editing (iii) Formatting

(c) There are ……….. types of formatting applied in MS Word.

 (i) two (ii) three (iii) four

III) MATCH THE FoLLoWINg

a)  Italizes the text

b)  8 Underlines the text

c)   Maximum font size

d) 72 Makes the text appear thicker and darker

e)  Minimum font size

Teacher’s Signature

Anuradha
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You can add bullets or numbering to your text to set it in a point-wise manner. When you turn the bullets and 

numbering feature on, every new line begins with a bullet or a number each time you press Enter. This feature is 

very useful when you are making a list or a point-wise report.

To add bullets or numbering, click on  to add bullets, or click on  to add numbering to your list. To 

choose the style of bullets or numbering, just click on the arrow next to the Bullets or Numbering icon from the 

Paragraph group.

To remove the bullets, select the text from which you want to remove the bullets or Numbering, and click on 

bullets or numbering.
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WoRd ART

Word Art is a text-styling tool of MS Word that allows us to use special effects such as bending, twisting, shading 

and rotating text in our documents. There is a gallery from which styles can be selected. Follow these steps.

•	 From	the	‘Insert’	tab,	click	on	the	Word	Art	button	in	the	‘Text’	group.	A	‘Word	Art’	box	opens.

•	 Select	a	Word	Art	style	and	click	on	it.	A	‘text	box’	appears	in	the	document.

•	 Type	the	text	in	the	space	provided	in	the	text	box.

•	 Choose	the	style	of	the	shape	from	the	‘Shape	Styles’	group	of	‘Format’	tab.

 To close Word Art, click away from the Word Art text.

INSERTINg gRAPHICS

‘A	picture	is	worth	a	thousand	words’.	This	quote	very	simply	conveys	how	important	graphics	like	Clip	Art,	Pic-

tures or images are used in a document.

INSERTINg A CLIP ART

Clip Arts are ready-made images used to illustrate a document. MS Word has a big gallery of Clip Arts. The various 

steps to insert a Clip Art in a document are listed below:

1.	 Place	the	cursor	in	the	document	where	you	want	to	insert	the	Clip	Art.	Now	in	the	‘	Insert’	tab,	click	on	Clip	
Art.

2. MS Word displays the Clip Art gallery on the right hand side of the window. Click on the Search for box and 
type the name of the picture you want and simply click on the Go button. 

3. Many pictures appear in the box. Click on a picture to select it.

 The picture will get inserted in the document. You can drag and resize the picture in your document.

Anuradha
Sticky Note
Please bring  the word "Pictures"  to the next line.
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INSERTINg A PICTuRE FRoM A FILE

The steps to insert a picture from a file are given below:

•	 Place	the	cursor	in	the	document	where	the	picture	is	to	be	inserted.

•	 Click	on	the	picture	option	in	the	‘Insert’	tab.

•	 An	‘Insert	Picture’	box	appears.	Find	and	select	the	desired	picture	in	the	computer.

•	 Click	on	the	Insert	button.	The	picture	gets	inserted.

Once the picture is inserted in the document, it can be moved from one location to the other, resized or text 

wrapped.

SETTINg A PAgE BACkgRouNd ANd BoRdER

Word allows you to put a border around most of  the items in your document, such as text, pictures and tables. You 

can add a border either to all the pages in your document or certain pages in your document.
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To create a page border in MS Word, 

•	 Open	Microsoft	Word.

•	 Click	on	the	Page Layout tab.

•	 In	the	Page Background group, click the Page Borders option.

•	 In	the	Borders	and	Shading	window,	click	the	Page Border tab.

•	 Select	Box if you want a square border around your page.

•	 Select	 the	Style of border you want on the page, which can be solid, dotted, or dashed. Select the Color  
and Width of the border. If you want to select artwork to use as the border, click the down arrow of the Art 
drop-down menu. 

•	 Once	you’ve	selected	all	the	border	options	you	want	to	use	in	your	document,	click	the	ok button to apply 
the border.

Activity 1: Type the following in a blank document and use bullets.
One who is spiritual, i.e. follows Dharma, imbibes the following ten qualities:

•	 Dhriti	 	 	 :	 Patience

•	 Kshama	 	 	 :	 Forgiveness

•	 Dama	 	 	 :	 Concentration	of	Mind

•	 Asteya	 	 	 :		 Non	stealing

•	 Shoucha	 	 	 :	 Cleanliness	(external	and	internal)

•	 Indriyanigraha	 	 :	 Control	of	all	senses

•	 Dhee	 	 	 :	 Intellect	backed	by	reasoning

•	 Vidya	 	 	 :	 True	knowledge

•	 Satya	 	 	 :	 Truthfulness

•	 Akrodha	 	 	 :	 Not	getting	angry

Activity 2: 

Write a recipe for how to prepare a sandwich using bread, butter and jam. Create list of ingredients required using 

bullets.	Use	numbered	lists	for	the	‘steps	to	make	the	sandwich’.

Activity 3: 

Using word art to create a banner for Teachers Day. Save the document as Teachers Day.

Activity 4: 

By looking at the below screenshot create a similar advertisement in search of your missing dog. Use appropriate 

word art styles and clipart/picture wherever required as per the instructions given.
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Activity 5: 

Your favourite bed time story is Red Riding Hood. Design the front page of the story book in an attractive manner.

Activity 6: 

It	is	the	‘World	environment	day’.	Your	class	teacher	has	asked	you	to	prepare	a	poster	to	be	displayed	on	the	class	

board. Use your imagination and design an attractive poster. Also set a page background and give a suitable border 

to	it.	For	ex	‘World	Earth	and	day	to	Day”	is	done	for	you.

 BRAIN dEVELoPER 

I) FILL IN THE BLANkS:

(a)  Ready-made gallery of pictures in MS Word  is called ………….

(b)   ………… is a text-styling tool of MS Word.

(c)   To remove bullets, click …….. button.

(d)   Bullets and Numbering are found in the ………. tab.

(e)   Clip Art is found in the ……… tab.

II)  uNSCRAMBLE THE FoLLoWINg WoRdS:

 TRARWOD …………..

	 STEBLLU	 …………..

 CUTPIER …………..

Teacher’s Signature
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A table is a grid of rows and columns that you can fill with text and graphics. 

A row is a horizontal series of cells whereas a column is a vertical series of cells. A cell is a rectangular box which is 

formed by the intersection of rows and columns.

Tables are used to organize and present information in a systematic manner. You can also use tables to input num-

bers and then perform calculations on them. 

CREATINg A TABLE
•	 To	create	a	table	in	MS	Word	2007,	we	first	open	the	Word	document,	and	place	the	cursor	where	we	want	to	

insert the table.

•	 Click	on	the	Insert tab.

•	 Click	on	the	drop-down	arrow	in	the	Tables group.

•	 A	drop-down	menu	opens	up.

•	 Click	on	the	grid	and	drag	the	cursor	to	select	the	number	of	columns	and	rows	you	want.

•	 The	table	gets	inserted.

dRAWINg A TABLE
 The steps to draw a Table are given below.

•	 Click	on	the ‘Insert’ tab.

•	 Click	down	on	the	drop-down	arrow	in	the	Tables group.

•	 A	drop-down	menu	opens	up.

•	 Click	on	the	draw Table option. Once this option is selected, the cursor changes to a pencil tool that helps 
you to draw a table.

•	 Click	and	drag	the	cursor	diagonally	to	draw	the	boundary	of	the	entire	table.

•	 You	can	draw	the	rows	and	columns	inside	it	one	by	one.

•	 A	set	of	Table Tools also appears on the toolbar for adding styles to the table being drawn.

To delete a table, click on the table inserted. Click on the Layout tab from the ribbon and click on delete option 

in the Rows and Columns group. A submenu opens up. 

•	 Click	on	delete Cells to delete the selected cell.

•	 Click	on delete Columns to delete the selected column.

•	 Click	on	delete Rows to delete the selected row.

•	 Click	on	delete Table to delete the selected table.

Activity 1: 

Create a table containing the names of your friends, their home address and telephone numbers. Use table grid to 

insert the table.
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Activity 2: 
Open MS Word window and create a table using the following information:

List of people to be invited List of items to be purchased List of games to be played

Charlie Balloons Four corners

Supriya Streamers Passing the parcel

Rohan Ribbon Musical chair

Vivek Caps

Kalpana

Mukthi

Perform the following operations for the above list for a birthday party celebration.

Step 1: Add the names of Rahul, Pooja, Dinki and Tej which is missing from the list of people to be invited.

Step 2: Cake, Eatables and Return gifts are missing from the items to be purchased.

Step 3:There are two more games to be played i.e. Pin the tail on the monkey and Simon says.

 BRAIN dEVELoPER 

I) WRITE THE dIFFERENCE BETWEEN THE RoWS ANd CoLuMNS

II) MATCH THE CoLuMNS

Column A Column B

1) Delete  a) Horizontal series of cells

2)		 Table	 b)	 Layout	tab

3)  Rows  c) Vertical series of cells

4)  Columns d) Insert tab

Teacher’s Signature
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Besides typing texts and creating tables, MS Word has many other features that make it the best tool for creating 

and maintaining official as well as personal documents. Some of these features are Header and Footer, Endnotes 

and	Footnotes,		Symbols	and	Special	Characters.	Let	us	learn	about	Header	and	Footer	in	this	lesson.

HEAdER ANd FooTER

Header refers to the top of the page that can bear a title, date, page number, a picture or even your name, or 

anything that you want. Footer can bear exactly the same things as the header, except that it is at the bottom of the 

page.

INSERTINg HEAdER ANd FooTER

The steps to insert a header and footer are given below.

1. Click on the Insert tab. Select the Header or Footer option, depending on what you want to insert, from the 
Header and Footer group.

2. A drop-down submenu opens up with a list of headers. You can scroll down to get many options. Once the 
header is selected, Header and Footer tools open up.

3. A dotted line marks the Header and Footer area in the document. Place your Cursor in the top box, that is the 
header, to insert text, pictures, time or date into it. Similarly, to insert text, pictures, time, date or any other 
thing into the footer, place the cursor in the bottom box.

 The Header and Footer tools help you to insert page numbers, pictures, clip arts, date and time in the header 
or footer.

HEAdER ANd FooTER
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FINd ANd REPLACE
The various steps to find a particular word or phrase and replace it with another word or phrase in a document are 

given below.
1. Click on the Find button in the ‘Home’ tab.	A	‘Navigation’	window	box	appears	towards	the	left	side	of	the	

document window.
2. Type the word that has to be found in the ‘Search box’ of  the navigation window.
3. The searched words will be highlighted in the document with yellow color.
4. To replace the word with another word, click on Replace button in the Home tab.
5.	 The	‘Find	and	Replace’	dialog	box	appears.
6.	 Type	the	word	that	has	to	be	replaced	in	the	‘Replace	with’	box	and	click	on	the	Replace/Replace All button.

SPELLINg ANd gRAMMAR
In MS Word, there is a built-in dictionary and a set of grammatical rules to check a document. An incorrect 

spelling of a word in a word document can be seen with a single red wavy line beneath it. Similarly, a line with 

grammatical mistakes are seen with a green wavy line.
The various steps to start Spelling and grammar checking are given below.
1.	 Place	 the	 cursor	 on	 the	word	with	 the	 spelling	mistake.	Click	on	 the	 ‘Review’	 tab	 to	 select	 ‘Spelling	 and	

Grammar’ button.
2.	 ‘Spelling	and	Grammar’	dialog	box	appears.	The	text	which	is	misspelt	is	highlighted	and	a	list	of	words	with	

the	correct	spelling	is	displayed	in	the	‘Suggestions	Panel’	at	the	bottom	of	the	dialog	box.	Choose	the	options	
from the table to move further.

oPTIoN dESCRIPTIoN

Ignore once Click on this button to ignore the error shown.

Ignore All Click on this button to ignore a particular error in the whole document.

Add to Dictionary Click on this button to add the highlighted word to MS Word dictionary.

Change First choose a word from the Suggestions panel, then click on this button to insert the 
corrected word.

Change All Click on this button to change the word wherever it appears in the document.

Auto Correct Click on a suggestion to accept it and then click on the Change button. This will 
change the word on its own while we are typing.
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Activity 1:
1. Open kiteWithoutThread.docx.

2.	 Create	a	header	“Stories	for	Today”(Insert HeaderBlank)

3. Create a footer containing the page number.

4. Double click outside the header/footer area in the document to return to the normal view.

5. Now scroll down to page 2 to see the header and footer.

6.	 Create	a	centered	heading	and	type	“Inspiring	Stories”.
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7. Create a footer with the page number and a text. Type “Robin Publications” in the text area.

Activity 2:
•	 Open	Abraham Lincoln.docx.

•	 Create	a	header	of	style	Austere (Even page).

•	 Go	to	the	footer	using	the	go To Footer command.

•	 Create	a	footer	in	the	Annual style. 
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•	 Go	to	the	header.	Change	it	to	“ETERNAL HERoES”

•	 Come	out	of	the	header	footer	view	to	the	main	document.

•	 Double	click	on	the	footer	to	edit	it.

•	 Type	“/”	and	insert	the	current	date.

•	 Set	different	header	and	footer	for	the	odd	and	even	pages	by	selecting	“different odd and Even pages” 
option.

•	 Increase	the	space	between	Header/Footer	and	edge	of	the	page	to	1	inch.

•	 Create	a	new	document	and	create	a	header	and	footer	in	the	following	style.

Header

Footer

Activity 3: 

Type the following paragraph in MS-Word :

My family consists of four people. My father who is the head of the family, my mother, my little brother and my-

self. We are a happy nuclear family. We love each other a lot and are always there for each other. We enjoy each 

others company and we laugh a lot. I feel blessed to have such a great family.

Step 1: Find	and	Replace	the	word	‘little’	with	‘younger’

Step 2: Identify and correct the spelling and grammatical errors

Step 3: Save the file

Activity 4: 

Type	the	following	paragraph	in	MS-Word.	Find	the	word	‘Geography’	and	replace	it	with	the	word	History	in	

the text below.
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geography

History is an account of the past. It is about the people, places and events in the world that have made a significant 

impact on the way we have evolved today.

Activity 5: 

Type the following sentence in MS Word.

Mango is my favouritefruit

•	 Are	you	getting	any	wavy	lines?	If	yes,	under	how	many	words.

•	 Select	the	sentence	and	click	on	‘spelling	and	grammar’	command.

•	 You	will	get	suggestions	to	change	or	ignore.	What	would	you	prefer	to	do	in	this	case	and	why?

 BRAIN dEVELoPER 

I) FILL IN THE BLANkS:

1. The Header and Footer tools are in the ………. Tab.

2. ……….. refers to the bottom of the page that can bear a title, date, page number, or even a picture.

3. Grammatical errors are indicated with ………wavy lines.

4. MS Word has a built-in ……….. to check the spelling of a word.

5. Misspelt words can be seen with a single ……..wavy line beneath them.

II) ANSWER THE FoLLoWINg:

1. What does a Find button do?

2.  What does a Replace button do? 

Teacher’s Signature
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MS Excel
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MS-Excel – Introduction to  
Excel Workbook and worksheetCh
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Microsoft Excel is a spreadsheet program developed by Microsoft for windows, MacOS, Android and IOS and is 

mainly used to perform arithmetical calculations. Excel is a spreadsheet program that allows you to store, organize, 

calculate and analyze information.  

LoAdINg MS-ExCEL 2007

Step 1: Click the  Start Button

Step 2: Click All Programs

Step 3: Click Microsoft Office

Step 4: Click Microsoft Office Excel 2007

When Excel window is loaded we see Book1 which is a workbook i.e collection of many worksheets. Every work-

sheet is divided into many  rows and columns. The horizontal lines are called rows and vertical lines are called 

columns.

The intersection of a column and row is called a cell. Every cell is referred by cell address ( The column name  

followed by the row number ). Cells are the basic elements of a worksheet where we type in data. Cell is a box where 

we can enter text or other data.

There are totally 10,48,576 rows and 16,384 columns in every worksheet. The rows are number from 1,2,3… and 

the columns are named as A,B,C…XFD.

By default an Excel workbook displays 3 worksheets. 

The columns are named  
from A,B,..Z,AA,AB, 

…AZ,BA,BB…BZ,CA…CZ, 
…ZA…ZZ, AAA,AAB, 
AAC…AAZ,ABA,ABB, 

ABC,…XFD

Charles Simonyi is the 
father of word and  
excel.

DiD You Know
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\

The cell which has the dark border around it is called the Active cell. In the example given below C6 is the active 

cell.
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ELEMENTS oF THE ExCEL WoRkSHEET

1. office button

In the top left corner of the screen you will find the round Office button.

2. Quick Access Toolbar

Next to the Office button we see certain icons which are frequently used which is called Quick Access Toolbar.

3. Name Box

The name box shows the cell address of the currently active cell. When multiple cells are selected it shows the cell 

address of the first cell from left top.

4. Formula bar

The formula bar shows the contents of the cell typed by us. It shows the text  / number  / formula entered by us.

5. Ribbons

Ribbon is the primary interface you see at the top of the excel window below the title bar. The Ribbon has 

collection of  tabs (7 tabs) and many icons.

6. Worksheet Area

The work area which is divided into many columns and rows is called worksheet area.

7. Sheet tabs

The sheet tabs are located just below the worksheet, on the left side.

8. Status bar

The status bar is present in the lower edge of the worksheet window which displays various information about an 

Excel Window. It can be located below the sheet tabs with the words Ready / Edit , Display buttons and Zoom 

Control.
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9. Scroll bar

Horizontal and Vertical scrollbars are present in the worksheet which is used to move to different area in the 

worksheet.

10. Layout Selector

It	has	three	buttons	as	Normal	,	Page	Layout	and	Page	break	view	buttons	to	see	the	worksheet	in	different	ways.

11. Zoom Control / Zoom Slider

The Zoom  slider is present in the bottom right corner and is used to see the worksheet from 10% to 400%.
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ENTERINg dATA IN THE CELLS

Before you can type data into a cell, you need to make it active. You can make a cell active by clicking directly in it 

or by moving the active cell left, right, up and down with the arrow keys on your keyboard. 

When you make a cell active, it becomes highlighted with a black border. Start typing and the data is inserted into 

the active cell. If you press enter after you’ve finished typing data into that cell, the cell below becomes active.

Activity 1.1:

Enter your name and age in cells A2 and A4 respectively.

Step 1 : Click on  cell  A2 enter your name and press Enter key

Step 2:  Click on cell  A4 enter your age and press Enter key

Step 3 : Close the workbook without saving. 

(Click on Office button and select Close. Click on No button not to save the changes.)

Text is displayed closer to the  

left border (left alignment)  

Number is displayed closer to the 

right border (right alignment)
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 BRAIN dEVELoPER 

CHooSE THE BEST ANSWER

1. Microsoft Excel is a popular __________________ program.

 a) Word processor    b) Image Processor  c) Spreadsheet 

2. A workbook is a collection of many ____________

 a) Cells    b) Pages   c) Worksheets    d) Documents 

3. The cell which has a dark outline border around it is called _______

 a) Name cell  b) Active Cell   c) Border cell  d) Inactive Cell

4. A workbook  by default has _____  worksheet(s).

 a) One   b)  Two    c) Three   d) Five

5. The ribbon has _____ tabs by default.

 a) 5      b)  6     c)   7   d)   8

6. There are totally ________ rows and _________ columns in every worksheet.

 a) 10000, 256   b) 1048576, 16384       c) 1048756, 16384

7. __________ shows the address of the active cell.

 a) Name box    b) Formula bar    c) Name cell    d)Status bar

8. A cell can contain _____________.

 a) Numbers    b) Text    c) both numbers and text

9. Numbers in a cell are __________ aligned.

	 a)	Left				 b)	Right				 c)	Centered			 d)	Justified

10. The basic unit of a worksheet into which you enter data in Excel is called 

 a) Cell    b) table    c) Box    d) Column

Teacher’s Signature

Every Excel sheet 
has 1,048,576 rows 

and16,384 (upto 
XFD) columns . D

id y
ou 

Kn
ow
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LoAdINg ExCEL ANd A NEW WoRkBook

Once Excel is loaded by default Book1 is available for us to use. Click the Office button and choose Close to close 

the Book1.

CREATINg A NEW WoRkBook

A new workbook is created by clicking on the Office button and selecting New option from it. A window as shown 

below appears. Select Blank Workbook and click the Create button which appears at the bottom right side.

The Steps are as below:
1. Click the Office button. The Office menu appears.

2. Choose New. The New Workbook dialog box opens.

3. Click the Blank Workbook icon. The Blank Workbook icon resides in the middle pane of the New Workbook 
dialog box.

4. Click the Create button. Excel creates a new, blank workbook based on the default template.

NAVIgATIoN IN A WoRkSHEET

Moving around the worksheet is called navigation. This is done either using the keyboard or mouse. When a mouse 

is used for navigation, point to a cell and click on it or scroll the mouse to reach a particular cell. When a keyboard 

is used the arrow keys are used to go up/down/left and right from the active cell.

When we create a new Excel workbook cell A1 is the active cell by default.

MS-ExCEL 2007 – CREATINg  
A WoRkBook Ch

ap
te

r

2
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Left	Arrow	/	Tab Moves one cell to the left

Right Arrow  /  Shift + Tab Moves one cell to the right

Up arrow Moves one cell up

Down arrow / Enter Moves one cell down

Home Moves to the first cell (Column A) of the current row

Ctrl + Home To go to the first cell in the worksheet (A1)

Ctrl + End To go to the end of the section of the worksheet that contains data. 

AddINg WoRkSHEETS IN A WoRkBook

By default three worksheets are available in a workbook. Only one can be an active worksheet. Click on the button 

next to the Sheet3 tab to add a new worksheet.

Click to add  
more worksheets

RENAMINg A WoRkSHEET

By default sheets are named as Sheet1, Sheet2, Sheet3…. The sheets can be renamed using the following steps.

1. Double-click the sheet tab you want to rename. You also can right-click the sheet tab and then click Rename 
on its shortcut menu. 

2. Replace the current name on the sheet tab by typing a new sheet name. When you begin typing a new name, 
the previous name disappears.

3. Press Enter.

Use Shift + F11 to  
insert a  

new worksheet
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QuITTINg ExCEL
We can close an Excel workbook which is currently open by selecting Close option under office button.

The Exit Excel button is used to Close all the open workbooks and come out of Excel 2007.

Activity 2.1:

Create a workbook in MS Excel with the following details

Step1: Click Office Button and click NEW

Step 2: Click Blank Workbook and click Create button

Step 3: Click	on	cell	B1	Type	SNO,	in	cell	C1	type	COUNTRY	NAME	and	in	cell	D1	type	CAPITAL

Step 4: Click on cell B2 and enter the number 1, in cell C2 enter Argentina and in cell D2 enter Buenos Aires.

Step 5 : Continue as step 4 to complete the table as below.

Step 6:	Save	the	workbook	with	the	name	“4A05_act1”	i.e.	your	class	sec	and	roll	Number	(Click	on	Office	button	

Save or use shortcut key Ctrl +S )

Step 7: Close the workbook (Click on Office button close)
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Step 8: Open the workbook 4A05_act1 and add 5 more entries to it. (Click on Office button and select Open. 

Select the folder where the file is saved. Double click the file name or Single click the file name and click Open 

button)

Step 9:  Save the worksheet (Click Office button and choose Save)

Step 10: Close the workbook. (Click the Office button and choose Close)

Activity -2.2

Load	MS	Excel	and	open	the	workbook	4A05_act1

Based on the steps of Activity 2.1 complete Activity 2.2 in Sheet 2.

Activity- 2.3

Step 1:	Load	MS	Excel	

Step 2: Open the workbook 4A05_act1 

Step 3: Click on Sheet 3 and enter the following data 

Step 4: Click on Cell B3 and enter S.No

Step 5: Click on cell C3 and enter Name of the Student. 

Step 6: Increase the Column width of C3 to show the entire text by placing the mouse pointer on the border be-

tween Column C and D and drag.

Step 7: Click on cell D3 and enter English

Step 8: Click on cell E3 and enter Maths

Step 9: Click on cell F3 and enter Science
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Step 10: Enter the student details of 5 students in cells B4 to F8 and save the file.

An excel cell can  
contain upto 32,767 

characters.
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 BRAIN dEVELoPER 

1. When Excel is loaded by default a workbook called __________ is created. 

2.  The New, Open, Close options are available under the ____________ button. 

3.  Moving around the worksheet using the keyboard or mouse is called _________. 

4.  The four basic keys used for navigation in Excel are ___________ keys.

5.  The shortcut key _______ + ________ is used to go to the the first cell in the worksheet(A1). 

6.  When an Excel workbook is created we can see _______ worksheets. 

Teacher’s Signature

It is not  
possible to name 
a worksheet as 

“History” in excel.
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FoRMATTINg IN  
A WoRkSHEETCh
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EdITINg IN A WoRkSHEET

Changing the contents of a cell is called editing. Double click on the cell or press Function key F2 to edit a cell. 

Type in the new data and finally press the enter key.

The two modes in which a worksheet appears are Ready mode and enter mode. When we open Excel workbook it 

appears in Ready mode. When we start typing in a cell it changes to Enter mode. When we press F2 and change 

the contents it shows as Edit mode. 

After pressing F2 key, Backspace key is used to remove the data from the left of the cursor position in a cell and 

Delete key is used to remove data at the current position in a cell.

SELECTINg CELL CoNTENT
•	 Click	on	the	desired	cell	to	select	it.

•	 Click	and	move	the	mouse	over	a	range	of	cells	to	select	them	all.

Note: Click outside the selected cell/ cells to deselect it

Shift + Space bar – To select a row in which the a cell is active

Ctrl + Space bar – To select a Column in which the a cell is active

Ctrl + A – To  select the entire worksheet

Shift + Space bar – To select a row in which the a cell is active

Use Ctrl +C for Copy, Ctrl + X for Cut and Ctrl + V for Paste.

dELETINg CELL CoNTENTS

To delete the contents of a cell, Click the cursor in the cell and press Delete key in the keyboard or type new data.

To CoPy CELL CoNTENTS

Cell contents can be duplicated by the copy and paste operation.

Select the cell or range of cells. Click the copy icon under the Home tab. Click on the desired cell where the data 

has to be pasted and then click the paste button.

Anuradha
Sticky Note
enter mode to be replaced as Enter mode.
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Cut and Paste option can be used to move the cell contents from one address to another. Cut, Copy and paste 

options can be selected from the Drop down list which appears when you click Right mouse button after selecting 

cells.

FoRMATTINg IN A WoRkSHEET

Changing the appearance of the cell content in a worksheet is called formatting. The formatting options available 

for a cell are Number, Alignment, font, border, Fill etc). Click on the Format Cells option under Format in the 

right hand side.

The mode (Ready /Enter/ Edit) appears in the left side of the status bar

 

NuMBER FoRMATTINg

When we format cells in Excel, we change the appearance of a number without changing the number itself. We can 

apply a number format (0.8, $0.80, 80%, etc). 

decimal Places: The up and down arrow in the decimal places scroll box is used to increase or decrease the decimal 

places. By default 2 appears in the box.

CoMMA SEPARAToR 

Click on the Use 1000 separator check box to get comma as per American number system. Ex: 120,560,450

Every excel sheet has 

17,179,869,184. If we 

need 1 second to fill out 

one cell, it would take us 

545 years to complete  

the whole sheet.
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Did you notice the Average, Count and Sum of the selected cells get displayed in the status Bar

CuRRENCy SyMBoL 

Under the Symbol dropdown list box the currency used in different countries are available. Select the currency  

Rs. English (India) to apply Rs to the selected range of cells. The Rupee symbol (`) can also be inserted.

In American number 

system Commas appear 

after every three  

digits, from right to 
left.

Use Ctrl + 1 to  
open the Format  
Cells dialog box
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TExT FoRMATTINg

Text data in a cell can be formatted by changing the font color, font size, font style etc. 

dATE FoRMATS

The date format used by Excel is American date format. i.e. mm/dd/yyyy (month/date/year)

To display the date as 08  April 2019 click on a cell C6 and enter 04/08/2019.  Press Ctrl +1 or select Format cells 

dialog	box.	In	the	number	tab	click	on	the	Date	option.	Select	Location	as	English	(India),	choose	the	required	

date type (14 march 2001) and click OK.

Do you know the name of  
first electronic computer? It is ENIAC 
(Electronic Numerical Integrator and  

Computer), introduced in 1946.D
iD
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ALIgNMENT

By default, text is left aligned and number and date values are right aligned. Excel provides us with two alignments 

namely horizontal and vertical alignments. Horizontal alignment is the position of the data with respect to the 

column width whereas vertical alignment is aligning the text contents with respect to the row height.

Text Orientation can be changed to a specific degree to display text in a slanting position.

Alt + H then A + T – Top alignment Alt	+	H	then	A	+	L	–	Left	alignment	

Alt + H then A + M – Middle alignment Alt + H then A + C – Center alignment

Alt + H then A + B – Bottom alignment Alt + H then A + R  – Right alignment 

ENIAC weighed  

more than 27 tons  

and took up 1800 

square feet.
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WRAP TExT

Use the Wrap Text button under Text Control to wrap lengthy text in a cell by displaying it on multiple lines within 

the cell.

SHRINk To FIT

Enabling Shrink to fit will automatically reduce the font size in a cell so that the text fits without wrapping.

MERgE CELLS

Merge cell is a facility that allows multiple adjacent cells to be combined into a single larger cell. This is done by 

selecting	all	cells	to	be	merged	and	choosing	the	“Merge	Cells”	command.

BoRdER

The grid lines which appear in the worksheet do not get printed. You can add borders to a cell or a range of cells 

in your worksheet. Excel allows you to quickly and easily add different types of borders to your individual cells and 

ranges of cells in your worksheet. You can use a number of different line types for your border. To add borders to 

cells, follow these steps:

1. Select the cell or range of cells that you want bordered.

2. Select the Cells option from the Format menu. You will see the Format Cells dialog box.

3. Click on the Border tab.

4.	 Select	the	Line	style,	choose	a	Color,	click	on	Outline	for	outline	border,	click	inside	for	border	between	the	
cells. (Outline will surround the entire cell or cell range.)

5. Select a line type from the Style area.

6. Click on OK.
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FILL 

The fill option is used to change the background color of the cells. Pattern color and pattern style can also be 

applied.

CHANgINg THE CoLuMN WIdTH ANd RoW HEIgHT

By default the column width is 8.43 and row height is 15. To change the column width click on the column name 

to select and right click. In the menu which appears select column width or row height to specify the numeric 

value.
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INSERTINg CoLuMNS ANd RoWS

Sometimes there may be a need for us to enter data in an existing worksheet in between. Excel gives the facility to 

insert blank rows or columns. 

To INSERT A RoW oR A CoLuMN

To insert rows, Click on the Home Tab. Click the Insert button and click Insert Sheet Rows Similarly a column can 

be inserted by clicking the Insert Sheet Column command.

Alternative method:

Right-click the column header to the right of, or the row header below, where you want the new column or row 

to appear, and then click Insert.

Note:

Before using the command the cell pointer should be positioned at the column where a blank column is to be 

created.
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dELETINg CoLuMNS ANd RoWS

To delete columns or rows

1. Select the rows or columns you want to delete.

2. Right-click the selection, and then click Delete.

3. Choose entire row or entire column to delete a row or a column.

AuToFILL

AutoFill is a very useful Excel feature that allows you to create entire columns or rows of data which are based on 

the values from other cells. In other words, Excel compares the selected data and tries to guess the next values that 

will be inserted. It is used to get months of the year, days of the week, number values to be filled in cells without 

typing the entire range. 

•	 Type	the	number	10,20	in	cells	A1,A2	respectively.	Select	both	the	cells	and	drag	using	the	Fill	icon	to	get	
other numbers with difference of 10.

•	 Type	January	in	cell	B5	and	drag	to	get	the	other	months	of	the	year.

•	 Type	Wednesday	in	cell	C5	and	drag	to	get	the	other	days	of	the	week.

Activity – 3.1

Create the following data range in sheet 4  of workbook 4A05_act1

Use Ctrl and the minus 
key to delete a row or 

column
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Using cell formatting options make the following changes.

•	 Change	52	to	$52
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•	 Change	6453	to	a	number	with	two	decimal	places	with	comma	separator.

•	 Display	the	date	as	05	January	2020

Activity - 3.2
•	 Change	the	font	color	of	cells	A1	to	A4	to	red

 Step 1: Click on cell A1

 Step 2: Select the cells A1 to A4

 Step 3: Right mouse click and select Format Cells

 Step 4: Click on Font Tab in Format cells dialog box

 Step 5: Select Red in Color drop down box

 Step 6: Click OK button.

Activity - 3.3
•	 Give	a	blue	border	to	cells	C1	to	C5

 Step 1: Click on cell C1

 Step 2: Select the cells C1 to C5
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 Step 3: Right mouse click and select Format Cells

 Step 4: Click on Border Tab in Format cells dialog box

	 Step	5:	Select	Color	to	Blue,	Line	Style	and	Preset	to	Outline	

 Step 6: Click OK button.

Activity - 3.4

•	 Change	the	font	style	to	Arial,	Size	14	to	all	the	data

 Step 1: Click on cell A1

 Step 2: Select the cells A1 to C5

 Step 3 : Right mouse click and select Format Cells

 Step 4: Click on Font Tab in Format cells dialog box

 Step 5 : Select Font name to Arial , Font size to 14

 Step 6: Click OK button.

Activity- 3.5
Create the following database in sheet 5 of workbook 4A05_act1

I: Insert two more rows between 111 and 112 and one more column between Tamil and Maths.

Step1: Click on cell A3. 

Step 2: Select Home tab Select Insert, Insert Sheet Rows

Step 3: Enter details of a student

Step 4: Repeat steps 2 and 3 to add another student details
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II: Change the name Jagat to Jagat prabu

Step 1: Click on B6

Step 2: Press F2 and change the name to Jagat Prabhu and press Enter key

III: Change the Tamil marks of Sesu to 87

Step 1: Click on the cell which has 78

Step 2: Change the mark to 87 and press enter key

IV: Change the font color to red

Step 1: Select all cells from A1 to E6

Step 2: Right mouse button click select Format cells and choose Font tab.

Step 3: Change the font color to Red

V: Increase the B column width to 13 and the row height of all rows to 20

Step 1: Click on the Column title B

Step 2: Right mouse click and select Column width and change it to 13 and click OK 

Step 3: Select all rows 1 to 6

Step 4: Right mouse click and select Row Height and change it to 20 and click OK

VI: give different background color for each row

Step 1: Select row 2 cells A2 to E2

Step 2: Right mouse click and select Format cells and select Fill tab

Step 3: Select a background color and choose OK

Step 4: Repeat Steps 1 to 3 to change the row colors of all records

VII: give all borders to cells A1 to E6

Step 1: Select cells A1 to E6

Step 2: Right mouse click and select Border tab 

Step 3: Select Inside option and click OK.
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Activity 3.6

Using AutoFill display the months of the year, days of the week and multiplication table of numbers 7 and 12 as 

shown below
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 BRAIN dEVELoPER 

1. The two basic alignment options available in Excel are ____________ and _____________.  

2. ____________ Option is used to combine contents of many cells into one. 

3. The Date values entered in a cell are _________ aligned by default. 

4. The normal, bold, italics options are available under ________ option in the Font tab. 

5. The two modes in which a worksheet appears are ________ and ________. 

6. The ___________box is used to place commas in a number value as per American number system.

7. The ____________ facility allows displaying the contents of a cell in many lines. 

8. The Shrink to Fit option automatically reduces the _____in a cell so that the text fits in the cell. 

9. There are _________tabs in Format cells dialog box. 

10. The _____ option is used to change the background colour of the cells.  

11. ___________ is the key combination to select the entire worksheet.

12. Multiple adjacent cells can be combined into a single larger cell with the _________ facility. 

13. If 4/6 is entered in a cell without applying any format then excel will treat this as a _________ value. 

14. The Wrap Text option is available under __________ tab in format cells window. 

15. To insert rows, Click on The Home tab, choose Insert and use  _______________ command.

Teacher’s Signature
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FoRMuLA 

One the most important aspects of Excel is its ability to perform calculations using a formula or function. A for-

mula is an expression which calculates the value of a cell. A formula starts with an equal to (=) symbol.

Formulas are instructions given by the user to perform arithmetic calculations whereas Functions are predefined 

formulae and are already available in Excel.

ELEMENTS oF A FoRMuLA

A formula is a combination of equal to sign, numbers, cell address and one or more operators.

•	 +	(plus	sign)	for	addition

•	 –	(minus	sign	or	hyphen)	for	subtraction

•	 *	(asterisk)	for	multiplication

•	 /	(slash)	for	division

ENTERINg A FoRMuLA

Steps to create a formula

1. Click the cell into which you want to enter a formula.

2. Type =. 

3. Type the expression representing the calculation you want to perform.

4. Press the Enter Key or click on an empty cell.

To enter a formula, execute the following steps.

1. Enter 5 and 3 in cells D1 and D2 respectively – Click on the cell D3.

2. To let Excel know that you want to enter a formula, type an equal sign (=).

3. For example, type the formula D1+ D2.

MS- ExCEL
FoRMuLAE ANd FuNCTIoNSCh

ap
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When the value in a cell is changed, Excel automatically recalculates the answer of the formula. This happens only 

when the formula is entered with cell address.

Formula with cell value

 = 5 + 3

Formula with cell address

= D1 + D2

CHANgINg A FoRMuLA 

To edit a formula, click in the formula bar and change the formula. Alternatively you can double click on the cell 

and change the formula.

uSINg THE AuTo SuM

If you need to sum a column or row of numbers, let Excel do the math for you. Select a cell next to the numbers 

you want to sum, click AutoSum on the Home tab, press Enter, and you’re done. When you click AutoSum, Excel 

automatically enters a formula (that uses the SUM function) to sum the numbers.

#VALuE is Excel’s way of saying, “There’s something wrong with the way your formula is typed.
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How to correct a formula error in Excel ?

Click the cell where you want to correct the formula. Now, you will see the existing formula in the formula bar 

that is available in the top of the Excel screen, just below the tool bar. Double click the formula bar and edit the 

formula as desired.

Functions are predefined formulae in Excel that performs both simple and complex calculations. 

Functions accept arguments and return value

All functions should start with an equal to sign ( =) .

Function name is followed by opening bracket, list of arguments and closing bracket.

Sum function is used to find the total of a set of number values or range of cells.

Examples:

=  Sum(34,2,1) Returns the total of 34,2 and 1  (37)
=  Sum( A2,A4,A6) Returns the sum of cells A2 , A4 and A6
=  Sum(A1,A2,A3,A4,A5) or

=  Sum( A1 : A5)   

Returns the sum of all numbers present in A1,A2,A3,A4,A5

MAx FuNCTIoN 

The Excel MAx function returns the largest value from a supplied set of numeric values. 

=  MAX (300,200,700) Returns the largest value (700)
=  MAX ( B1, B3, B4) Returns the largest from the cells  B1, B3 and B4 
=  MAX (B1, B2, B3, B4, B5) or

=   MAX ( B1 : B5)   

Returns the largest of all numbers present in B1, B2 , B3 , B4, B5
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Min Function: Returns the smallest of a set of numeric values. The arguments are given similar to MAX function.

When a Cell which is empty is used in an arithmetic formula it is taken as value 0

Activity – 4.1

Create the following format in sheet 6 of workbook 4A05_act1

Product’s Name Sale in 2012 Sale in 2013 Sale in 2014 Total

Step 1: Enter 3 entries for the above table. You may enter details of any product like eatables, computer parts, soft 

drinks, toys etc. Then perform the following tasks on the worksheet.

Step 2: Enter two more entries and save them. 

Step 3: Find the total sales for each product using formulae.

Step 4: Also display the grand total which displays all product total of all three  years. The file after entry should 

be as below.

HINTS: 
 In cell E2 enter the formula =B2+C2+D2 and drag till E6 to get other values.

 Use Auto sum to get grand total or go to E7 and enter =sum (E2..E6)
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Activity- 4.2

Use sheet 7 of workbook 4A05_act1 to find the output for the following after typing in the worksheet. 

1. =50*5

2. =40+5

3. =30-6

4. =Min( 12,  45, 13)

5. =Max( 34, 45, 98)

6. =Sum( 10, 20, 30)

7. =200*0

8. =12-7

9. =67+4

10. =Sum( 100, 200,300)
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Activity-4.3

Create the following data in sheet 8 of workbook 4A05_act1

Now perform the following operations

Step 1: Find the number of items bought

Step 2: Find the minimum cost

Step 3: Find the maximum cost

Step 4:  Find and display the amount which is quantity * cost

Step 5: Find the total cost of the items.

Use Formulae to find Amount, Minimum cost, Maximum cost, Items bought and Total cost of items.

Android is a mobile 
operating system primarily 
designed for touchscreen 
devices like smart phones 

and tablets.

Did
You
Know?
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The worksheet after the steps should be as below:-

    

    

Android was developed  
by Google in 2008.
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 BRAIN dEVELoPER 

I) FILL IN THE BLANkS

1. Formula in Excel should begin with ______.

2. Formulae are used to perform _____________.

3. When you enter a formula in a cell the answer is displayed in the ______.

4. When a cell contains a formula the same appears in the ______________.

5. To find the total of a set of numbers the ___________ function is used.

6. The Max function gives the _________ value in a given set of data.

7. We can use the Min function only on ___________ data.

8. We cannot perform the _________ mathematical operation with zero.

9. The 4 basic arithmetic operators used in Excel are __ , ___ , ___ and ___.

10. Always enter the formula with cell ________, so that when the data changes the answer automatically 

 changes.

11. = 67+*34-3 formula gives the result as _________.

12. The Auto sum tool is on the _____________ tab.

II) IdENTIFy ANd LIST THE CELL AddRESS, oPERAToRS, ANd  
CoNSTANTS IN THE BELoW FoRMuLA 

 = A4 + B4 * 2 + C4 – D4 + E4*50 –F4/ 3

Cell Address

Constant value

Mathematical Operator
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III) MATCH THE FoLLoWINg

1.  = 10+2+4-1  a.  10

2.   = 10-2*3 b.  500 

3.   = MIN(10,20,15) c.  12

4.   = MAX(12,500,50) d.  15

5.   = 144 / 12 e.  4

6. Sum of all numbers in the cells A1 to A10 f.  Product of two numbers in A3 and A4

7.		 #VALUE	 g.		Answer	changes	when	values	are	changed

8.  Alt + Equal to sign h. =Sum ( A1: A10)

9.  = A3* A4 i.  Auto Sum

10.  Formula entered with cell address. j.  Error in formula

 

Teacher’s Signature
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User Skill  
Typing Tutor
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TyPINg TuToR  
INTRoduCTIoN

 The knowledge of touch typing has become inevitable today in the use of computers.

 With typing tutor, you can learn touch typing in an easier and simple way.

 It is very similar to you that there are 26 letters in English alphabet. All these 26 letters are presented in the 
computer keyboard too.

 But, 26 letters are not arranged in an alphabetical order.

 The letters in the keyboard is arranged in QWERTY order.

TyPINg STEPS:

Follow the steps below:-

Step 1: First of all place your hand on the keyboard.

Step 2: Place your

 Little	finger	of	your	left	hand	gently	on	the	‘A’

 Ring	finger	on	‘	S	’

 Middle	finger	on	‘	D	’

 Index	finger	for	both	‘	F	’	and	‘	G	’

Step 3: Place your

 Little	finger	of	your	right	hand	gently	 
on	the	key	semicolon	‘	;	’

	 Ring	finger	on	‘	L	’

 Middle	finger	on	‘	K	‘

 Index	finger	for	both	‘	H	’	and	‘	J	’
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Step 4: Place both your left and right thumbs on the spacebar key.

Lets	start	typing.	Whatever	it	may	be	letter	or	numbers	all	most	all	the	keys	you	can	see	around	your	fingers.

LEFT HANd FINgER
Name of the Finger keys on the keyboard

Little	Finger A

Ring Finger S

Middle Finger D

Index Finger F,G

Thumb Spacebar

RIgHT HANd FINgER
Name of the Finger keys on the keyboard

Little	Finger ;
Ring Finger L
Middle Finger K
Index Finger J,H
Thumb Spacebar

THE QWERTy LAyouT

The	keys	on	the	keyboard	is	arranged	in	QWERTY	layout.	The	layout	is	referred	to	us	as	“QWERTY”	because	of	

the arrangement of the keys in the upper row is QWERTY.
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HoME RoW

The	finger	of	an	experienced	typist	never	“rest”	However,	if	we	could	ask	the	fingers	where	they	spend	most	of	their	

time, it is over the home row.

When you are still learning to access keyboard, be careful to keep at least one finger of each hand anchored over 

the home row.  

uPPER RoW / QWERTy RoW

QWERTY Row is located just above the Home row. It contains many number of characters.

LoWER RoW

Lower	Row	is	located	just	below	the	home	row,	contains	limited	number	of	keys.

NuMBERS RoW

Numbers Row is located above the upper row, number keys are also available in a separate place at the right side 

of the keyboard.

ANCHoRINg

Anchoring means to keep a finger in very light contact with its home row key.

During the early stages of learning keyboard, this is necessary for the brain to develop a sense of position for the 

hands and fingers.

As you become a more skilled typist, your fingers will automatically move to the correct position of the keys.
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